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Getting Started
Each SoftwareVAULT collection contains thousands of programs and resources of every size and 
variety.    To help you find your way through this sea of software, we have included the 
SoftwareVAULT Librarian program.    This is a program that will ......

1 Let you sort through thousands of programs and resources in the SoftwareVAULT collections.
2 Help you find programs of interest.
3 Help you transfer these programs or resources to your hard drive so that you can use them.

Please note that to use SoftwareVAULT files you MUST transfer them to your hard drive! 

The files on the CD-Rom are compressed and must be "UNZIPPED" to your hard drive so they can 
be accessed.    (Don't worry, the Librarian does this automatically for you.) 

(We "ZIP" our files up so that we can include more software on each SoftwareVAULT collection, 
giving you more value for your dollar.)



Tutorial... A lesson in fun
How To Use the Files on This CD-Rom.

You can use any of the thousands of programs and resources on a SoftwareVAULT Collection with 
just a few easy steps...

Find and select a program or resource you'd like to use. You can either "browse" through various file 
"Groups" using the "Contents" menu item or "Find" specific subjects using the "Search" menu item. 
You'll discover long lists of files, each followed by a one sentence description of what that file does. 
Once you find one that looks interesting, double-click on it with your mouse. A "File Operations" box 
will appear.

Select to "Unzip" the file to your hard drive. There are four different options on the "File Operations" 
box. You can either view extended information about the file, browse the contents of the "zip" file, 
copy the file to your hard drive, or unzip the file to your hard drive.    If you are curious, you can view 
the extended information on the file you have selected. Not all files have extended information, so 
don't be surprised if it's the same as the one-sentence description. Unless you're a veteran 
SoftwareVAULT user, browsing the file contents and copying the file to your hard disk might be 
confusing. (Note for veteran users: "Browse file contents" serves as a handy GIF viewer for GIF 
files.) OTHERWISE, THE MENU OPTION YOU ALWAYS NEED TO SELECT IS "UNZIP TO HARD 
DRIVE". Selecting "Unzip to hard drive" will properly decompress the file and transfer it to your 
computer.

Select the drive and name a directory in which to put your file. Once you've chosen to unzip the file to
your hard disk, a directory selection menu will appear on your screen. Choose the directory you 
would like to hold the file. IT'S USUALLY A GOOD IDEA TO CREATE A NEW DIRECTORY FOR A 
ZIP FILE. Don't worry. The SoftwareVAULT Librarian can do this automatically. Simply make up a 
new directory name and type it in the "Dir Name" box.    Note that the directory you type in will be 
created in "Directory" path specified under the "Dir Name" box. To change the path, click through the 
"Directories" selection box until you find a path that matches where you want to create your new 
directory.    Make a note of where you create your directory so you can find it once the Librarian is 
finished! Finally, the Librarian will ask you if you want to "create the directory", and when it does, 
answer "Yes".

Use your file. Exit the Librarian and go to the directory you created to hold your file. You will discover 
that your one ZIP file has probably decompressed into a collection of smaller files. To start the 
program, look for the file with a ".exe" on the end of it's name. This is the main executable for the 
program. Running it should start the program!





File Operations
This is the file operations window that appears when you double click on a file name in the browser 
window.    Click on the area of the window that you are interested in.



Copy a File
To copy a file, do the following....

· When in the File Browser window, double click on the file you are interested in.    This will cause 
the File Operation Dialog to appear.

· From the File Operation Dialog, click on "Copy To Hard Drive".    This is the third item on the list 
of things to do.

· Selecting this option will display a "File Save As" window.    Here, you will need to choose the 
directory where the file(s) will be copied.

If you are Copying more than one file to your hard drive, we recommend that you put each file in a 
different directory.    If you don't, some files with common names may overwrite each other.



UnZip a File
To unzip a file, do the following ....

· When in the File Browser window, double click on the file you are interested in.    This will cause 
the File Operation Dialog to appear.

· From the File Operation Dialog, click on "Unzip To Hard Drive".    This is the fourth item on the list
of things to do.

· Selecting this option will display a "File Save As" window.    Here, you will need to choose the 
directory where the file(s) will be unzipped.

If you are unzipping more than one file to your hard drive, we recommend that you put each file in a 
different directory.    If you don't, some files with common names may overwrite each other.



View a Picture
To view a GIF or other picture, do the following....

· When in the File Browser window, double click on the file you are interested in.    Make sure that 
the extension of the file is ".GIF", ".BMP" or ".PCX".      This will cause the File Operation 
Dialog to Appear.

· From the File Operation Dialog, click on "Examine File Contents".    This is the second item on 
the list of things to do.

Loading a GIF picture for viewing may take a few moments. See the "Tutorial" section of this help file
for more details on using the File Operations box. Or, press the "Show Me" button below.



Graphics Viewer
The Software Librarian allows you to view GIF (digitized pictures found in Category #16 of most 
collections) directly off the SoftwareVAULT CD-Rom.    Select "Browse File Contents" from the "File 
Operations" box to view a GIF picture.

Loading a GIF picture for viewing may take a few moments. See the "Tutorial" section of this help file
for more details on using the File Operations box. Or, press the "Show Me" button below.



Menus
From the menus listed below, you can do most anything in the SoftwareVAULT Librarian.    The 
menus will assist you in navigating the Librarian and performing all functions.

File Menu
Contents Menu
Search Menu
Text Menu
All CD's Menu
Windows Menu
Help Menu



File Menu
From the File Menu you can perform many utility functions including changing CD-Rom's, Setting up 
your printer, printing catalogs or setting up a BBS import of any SoftwareVAULT collection.

Change CD-Rom
Select "Change CD-Rom" to use other SoftwareVAULT Collections.    When you select    "Change 
CD-Rom", be sure to place the CD-Rom you would like to use in your CD-Rom drive.

If you are running the Librarian directly from your CD, this option is disabled.

Exit
Select "Exit" to leave the SoftwareVAULT Librarian.



Contents Menu
The Contents Menu allows you to explore SoftwareVAULT in two different ways with either Group 
Browser or Browse-Copy Files. It also contains Hottest Hits and Statistics.

Group Browser
Brings up an array of buttons. Each button highlights a certain topic of software. Click on a button to 
explore the categories contained in that group. Clicking on a specific category will bring up a 
complete list of all the programs and resources contained in that category. Note: If there is only one 
category in that group, the files list for that category will immediately appear. See the Tutorial section 
of this help file to see how to use these programs.

Browse-Copy Files
If you don't want to sort through groups of software categories, you can explore the entire category 
list. Clicking on a specific category will bring up a complete list of all the programs and resources 
contained in that category. See the Tutorial section of this help file to see how to use these programs.

Hottest Hits
Each SoftwareVAULT collection contains an assortment of the very best shareware programs on the 
market today. "Hottest Hits" Info contains complete reviews of these outstanding programs.

Statistics
Statistics provides a statistical breakdown on the makeup of this SoftwareVAULT Collection. It 
displays File Areas, Total number of files in each area and the total number of File Bytes used by 
each area.

File Operations Box
There are four different options on the File Operations box. You can either view extended information
about the file, browse the contents of the zip file, copy the file to your hard drive, or unzip the file to 
your hard drive.    If you are curious, you can view the long description of the file you have selected. 
Not all files have extended information, so don't be surprised if it's the same as the one-sentence 
description. Unless you're a veteran SoftwareVAULT user, browsing the file contents and copying the
file to your hard disk might be confusing. (Note for veteran users: Browse file contents serves as a 
handy GIF viewer for GIF files.) OTHERWISE, THE MENU OPTION YOU ALWAYS NEED TO 
SELECT IS UNZIP TO HARD DRIVE. Selecting Unzip to hard drive will properly decompress the file 
and transfer it to your computer. For a complete explanation of the file transfer process, see the 
Tutorial section of this help file.



Search Menu
The SoftwareVAULT Librarian allows you to search for files that interest you in several different ways:

Choose Category
Executes the Librarian's Browse-Copy function for a specific category.

Find Filename
Allows you to find files based on their title. Type a title into the Find File box and click on the OK 
button. The Librarian will assemble a list of the files with titles similar to the one you specified. See 
the Tutorial section of this help file to see how to use these programs.

Find Text
Allows you to run a keyword search to find files on certain subjects. Type a keyword into the Find 
Text box. The Librarian will sort through the descriptions of all the files on the disc and will assemble 
a list of files with subjects related to your keyword. See the Tutorial section of this help file to see how
to use these programs.



Text Menu
The text files contain information on how the SoftwareVAULT collections are assembled and how you
can register shareware programs requiring registration.    You will also find information about Digital 
Impact, the copyrights on the Librarian, warranties and Technical Support. There is also information 
about the virus precautions we take and the utilities we use.



All CD's Menu
Selecting All CD's allows you call up a master files listing for all of the other SoftwareVAULT 
collections.    The master listing is topically organized by group, using the same twelve groups found 
in the Group Browser.    Note the number next to each file name. Each number corresponds to a 
collection in the SoftwareVAULT series.

1 Collection 1
2 Collection 2
3 The Gold Collection
4 The Games Collection
5 The Collection for Windows
6 The Platinum Collection
7 The Emerald Collection
8 The Ruby Collection
9 The Games 2 Collection

(Check the top of the All CD's listing for the latest names and numbers.)

If you would like to examine a listed file use the Change CD-Rom function found under the File menu
to switch to the appropriate collection and then the Find Filename function in the Search menu to 
retrieve the file.

All CD's use Windows Write to view the lists of files. Windows Write is capable of searching lists for 
keywords as well as printing them out.



Windows Menu
The Windows menu item allows you to arrange your Librarian screens in various ways.

Cascade
Select Cascade to evenly spread your Windows across the screen.

Tile
Select Tile to squarely arrange your Windows side-by-side.

Arrange Icons
Select Arrange Icons to neatly arrange the icons for minimized Windows.

Close All
Select Close All to close every open window except for the main Window.



Help Menu
Selecting help opens this help file. If you are having difficulty understanding how to use this help file, 
click on the "Help" menu item above.    Or, if you're really in a hurry, click on the Speedbar button.



Speedbar
The SoftwareVAULT Librarian is equipped with a speedbar.    This is a group of pushbuttons that 
makes using the Librarian quick and easy.

This button will clear all windows and activate the Group Browser.    This is the series of large picture 
buttons in the center of the main screen.

This button will activate the search by category function.    A list showing all categories available will 
pop-up and you will be allowed to select a category to browse.

This button displays the Find Text window.    This is where you enter any text that you want to find, 
and the Librarian will find all files with this text in their description.

Clicking your mouse on this button will close the Librarian and return you to the Windows Program 
Manager. This has the same effect as selecting "Exit" from the File Menu.

Clicking this button will get you Help in a hurry.



Keyboard
Alt-F    -    Activates the File menu.

Alt-C    -    Activates the Contents menu.

Alt-S    -      Activates the Search menu.

Alt-T    -      Activates the Text menu.

Alt-A    -      Activates the All CD's menu.

Alt-W    -      Activates the Windows menu.

Alt-H    -      Activates the Help menu.



Digital Impact
Digital Impact is principally a software publisher.    We design, publish and directly support a line of 
proprietary software in several categories.

Our software products range from a menu and utilities package specifically created for the novice to 
average user to multi-media programs for the home.    In addition, we assemble, manufacture, and 
distribute the SoftwareVAULT collections of shareware on CD-ROM and the ImageVAULT collections
of digitized images on CD-ROM.

Our SoftwareVAULT line    is unique because it includes a large number of programs, several 
thousand, and because no program is duplicated by any other general collection.    Users get 
hundreds of megabytes of programs, many of which are better than commercial programs.    As a 
bonus, we include free of charge the SoftwareVAULT Librarian, a complete database of all of the files
on the CD.

With this    powerful tool you can    search for any subject.    When you select a    program, The 
Librarian creates    the necessary directories (if instructed to), copies the program from the CD-ROM, 
and unpacks the    programs and    files for      you. The    Librarian can    also create directory    listings 
for    most any    BBS, or    export information to a file in any    one of several word processing    
formats, and filter or search by any subject.

What    really    distinguishes    Digital    Impact    from    other    software publishers    is    the    depth    of 
knowledge    we    maintain for all the software we carry. When you    telephone our technical support 
staff, you speak with an experienced person    who is familiar with not only our products, but also with
every facet of the complex problems the industry faces.

We stand behind every product we sell and we value every one of our customers. We    provide 
genuine help when    you need it and    we offer the      same    high      quality    of      service    to      end-
users,    dealers, distributors and OEMs.

We maintain a 24-hour Bulletin    Board with separate conferences for each of    our products. In    
addition to the    free software which    is available    on    the    Bulletin    Board,    information    is    
exchanged by programmers, dealers    and VARs and    the Bulletin Board    may also be used    to 
send    us a    technical inquiry,    request assistance    with a special problem or ask for technical 
support. Our products may also be ordered by credit card on the    Bulletin Board at any time of the
 day or night, or by phone during business hours.

When you    buy, resell or distribute    Digital Impact's products, you also    receive    the    knowledge    
and    experience    necessary to ensure satisfaction and performance.

Shareware Authors that wish to have their software approved for any of    our SoftwareVAULT    
Collections should    send complete    copies of their programs (uncrippled and as you want them to 
appear) to:



AUTHOR SUBMISSIONS
Digital Impact, Inc.
6506 South Lewis      Suite 250
Tulsa, OK    74136
BBS:    (918) 742-8037
Phone:    (918) 742-2022



Other Products
SoftwareVAULT: The Games 2 Collection
Open this collection for the hottest games on the market today! A perfect gift for anyone. 
Contains games of all types...    Virtual Reality games , arcade games, war games, role 
playing games, casino games, adventure games, filght simulator games, puzzles and much, 
much more!    Of course, we include our latest Hot Hits.    All new games will provide you 
with months of entertainment, thousands of games packed on one CD-ROM. Comes 
complete with the SoftwareVAULT Librarian to manage the many files included.

SoftwareVAULT: The Ruby Collection
The eighth of the SoftwareVAULT Collections, and what a collection it is.    Thousands of all
new files, new Librarians for both DOS and Windows, new file search capabilities, and an 
all new history file so that you can find any file in any collection.    Windows games, 
business applications, fonts, clip art, virus protection, and much, much more!    

SoftwareVAULT: The Emerald Collection
Exploring a shareware collection has never been so easy!    The latest edition of the 
SoftwareVAULT Librarian allows you to quickly and easily explore the thousands of files on
the Emerald collection.    The enhanced Librarian features a user-friendly interface, global 
search functions, and extensive help capabilities.    The Emerald Collection contains all new 
files from 1994 with no duplicates from earlier collections.    These are a few of the reasons 
that the Emerald Collection is Fantastic!

SoftwareVAULT: The Platinum Collection
Over 600 megabytes containing thousands of the finest and most recent shareware programs 
and resources available.    Over 50 exciting categories including Windows, games, graphics, 
music, multimedia, productivity, desktop publishing, and much more. Both a Windows and 
DOS interface will help you explore the vault for applications that interest you!

SoftwareVAULT: Collection for Windows
A comprehensive collection of every Windows utility imaginable.    An absolute necessity for
both home and business Windows users. Includes file managers, network utilities, desktop 
publishing programs, Windows games, business applications, fonts, clip art, virus protection,
and much, much more!    Thousands of programs and resources packed on one CD-ROM 
disc.    Comes complete with the SoftwareVAULT Librarian to manage the many files 
included.



 SoftwareVAULT: The Games Collection
Unseal this games collection of the hottest games on the market today! A perfect gift for 
anyone. Contains games of all types... Arcade games, war games, flight simulators, casino 
games, adventure games, puzzles and much, much more!    Months of entertainment, 
hundreds of games packed on one CD-ROM. Comes complete with the SoftwareVAULT 
Librarian to manage the many files included.

 SoftwareVAULT: The Gold Collection
The third release in the SoftwareVAULT series, The Gold Collection contains thousands of 
the best shareware programs, including such recent software categories as Windows NT 
programs. It is truly one of the finest software collections ever assembled! The Gold 
Collection comes complete with the latest DOS and Windows versions of the 
SoftwareVAULT Librarian program.

ImageVault
Sharp, fresh images.    Substance and style.    Simplicity.    Hundreds of impressions from 
nationally renown photographers capturing people, lifestyles, industry and nature.    
ImageVAULT electrifies your projects with stock photos that steal the breath and excite the 
mind.    Quality resonates in this extraordinary collection of imagery compiled with 
professional standards firmly in mind. Each image is available in three different image 
formats .... Wallet, Snapshot and Standard.

ImageVAULT Pro
The highest resolution, brilliant color, flawless images.    ImageVAULT Pro is a potent, cost-
effective solution to your photographic needs.    The agile browsing software optimizes 
freedom of choice.    Every shot is effortlessly customizable to fit the project; crop, resize, 
retouch, combine and rotate however you please.    Absolutely royalty and credit free.    
Create exceptional graphics with contemporary, powerful photographic images.    Bring 
newsletters, invitations, and presentations to life!    The professional stock photos are 
available in five different formats... Wallet, Snapshot, Standard, Large and Poster.

Ozzie's World™
A kid is naturally curious about how things work in the world around them.    Ozzie's 
World™ is the fun way to help them understand.    It develops memory, critical thinking, 
problem solving and basic science skills, too!    With engaging animations, sound effects, 
stories, games and music, Ozzie's World™ is a multimedia wonderland for parents, 
educators and kids alike!

In Ozzie's World™, kids join Ozzie S. Otter™ on a magical, animated, earth-friendly 



exploration.    It's a wonderfully engaging environment where animals talk and share their 
stories, and where puzzles, games and fun scientific activities are hidden around every 
corner.    Kids will be enchanted as they learn about science and simple ways to protect the 
environment.

Professor C.D. Smart
Professor C.D. Smart is great for first time computer users needing to learn Windows 
beginning with the basics.    It's also great for experienced users wanting to enhance their 
working knowledge of Windows.

· Learn what YOU need to learn and learn it at YOUR own pace.
· Your teacher's voice will guide you step-by-step, just like a classroom.
· Learn to change your Windows system to meet YOUR needs.
· Learn to keep your files organized and easy to find.
· Learn to make icons for those programs you use frequently.

The Course Outline includes the following lessons ....

1 Course Instruction
2 Working with Windows
3 Executing and Controlling Programs
4 Managing Program Manager Groups
5 The Options Menu
6 Getting Help
7 Disks, Files and Directories
8 The File Manager
9 Customizing Your Windows Environment
10 Printing

This is the easy interactive way to learn the basics of Microsoft Windows.    Through the use of audio 
instruction, simulation, and hands-on training with your own Windows system, you will become a 
Windows power user.
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Active File
This area displays the actual name of the file that you want extra information on, to see the contents 
of, or to copy / unzip to your hard drive.



Browse File Contents
If the file you are interested in is a Zip file, the file will be unzipped in memory and the contents of the
file will be displayed in a list.
If the file is a graphics file (with a .GIF extension), the Librarian's graphics viewer will display the 
picture.



Cancel Button
Clicking on this button will cancel your request and return you to the prior window.



Copy To Hard Drive
Selecting this option will display a "File Save As" window.    Here, you will need to choose the 
directory where the file(s) will be copied.

If you are Copying more than one file to your hard drive, we recommend that you put each file in a 
different directory.    If you don't, some files with common names may overwrite each other.



Extended Information
In many cases, there is additional information about each file.    Clicking on this option will display this
information.



Ok Button
Clicking on this button will process your request.



System Button
This is a small menu that will allow you to move the window with the keyboard arrows, close the 
window or call the Windows Task Manager.



Title Bar
This displays the name that the window is called.    It is common to the Microsoft Windows Operating 
System.



Unzip To Hard Drive
Selecting this option will display a "File Save As" window.    This is where you choose the directory to 
unzip the file(s).

If you are unzipping more than one file to your hard drive, we recommend that you put each file in a 
different directory.    If you don't, some files with common names may overwrite each other.



All CD's
This is a reference to a history file of all CD-Rom collections from the SoftwareVAULT.



Areas
An Area is a sub-directory on the CD-Rom that contains all files of a simular nature, i.e. "Games". We 
also use the word "Category" interchangeably with "Area".



Arrange Icons
As windows are minimized,    they are represented on your desktop by little pictures... also known as 
icons.    This command puts them all neatly in a row.



BMP
BMP stands for Bit MaPped graphic.    This is a common graphics type used by Windows programs.    
A .BMP graphic can also be used for Windows wallpaper.



Browser
This is the large list box that allows you to see a listing of the files in a given Area or Category.



Byte
One byte equals one character.



Cascade
An arrangement of windows on a screen that looks much like a deck of cards sideways.    You can see 
the top window in full, and you can also see the title bar of each winodw behind the top one.



Category
An Category refers to a group of files on the CD-Rom that contain files of a similar nature, i.e. "Games". 
We also use the word    interchangeably with "Area".



Close All
This means to close (not minimize) all windows except the main window.    This command is fast and 
absolute.



Dialog
A window that asks you a question requiring a response, or giving you an information message.



Digital Impact
The company that produces the SoftwareVAULT collections of CD-Roms.



Extension
The part of the filename that comes after the period.    For example, if the file was called 
"MYNAME.EEE", the "EEE" would be the extension.



Find File
Using the File File dialog from the Search Menu, you may enter any filename (or part of a filename) for 
the Librarian to search for.



GIF
Graphics Interchange Format.    This is a picture format created by Compuserve and is very popular.



Groups
A Group may contain references to one or more Areas or Categories.    If a Group button on the main 
window is "grayed out", it means that there are no files or Areas that apply to that collection.



Librarian
This is the Files Manager designed for and used by the SoftwareVAULT collections.



PCX
An image file common to PC Paintbrush published by Zsoft.    This application comes with the Microsoft 
Windows Operating System and can be found in the Accessories group on most computers that use the 
Microsoft Windows Operating System.



Shareware
Shareware software is a unique marketing approach which allows you to purchase software directly from
the author.    This eliminates costly marketing,    promotion, and packaging;    allowing you to obtain 
quality software at a fraction of the commercial cost.    You are encouraged to examine a program, copy 
it, and pass it on to    friends.    If you find the software program useful, you are asked    to register with 
the software author.    This usually means paying a registration fee directly to the shareware author.    In   
return for    this registration fee,    you receive the right to continue to use the software and added benefits
such as full    documentation, technical support, and future updates of the program.    This is the Try-
Before-You-Buy concept.



SoftwareVAULT
The name of a series of CD-Roms produced by Digital Impact.    These CD-Roms contain Shareware 
files and programs, Public Domain files and programs, and Pictures or Clip Art that is Free.



Speedbar
A bar containing buttons or picture buttons.    This bar is usually across the top of an application program
and is also called a toolbar.    It's purpose is to provide a fast access to common functions.



Tile
An arrangement of windows that looks like the wall tile in a shower.    Each winodw has its own square....
or tile.



Unzip
The process of removing (uncompressing) files from their envelope.    This is the opposite of Zipping (or 
compressing) the files.



Zip
A process of compressing many files into one file.    This process saves space and insures that files stay 
together.






